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GETTING STARTED

Introduction

Installation Media

World Class
Manager User’s
Guide

Getting Started

Tutorials

Command Reference

Appendices

Welcome to World Class Manager, International Thomson
Publishing’s electronic gradebook software.

World Class Manager lets you:

* Store your student’s scores.

* Automatically recalculate grades.

* Enter your own weighting and letter grade criteria.
¢ View and print numerous reports.

» Import results from online activities.

If you received a Thomson World Class Learning™ Testing
Tools CD, it contains a program that installs all of the system
components, including World Class Manager, on your
computer’s hard disk.

If you received a World Class Manager diskette, it contains a

program that installs World Class Manager on your computer’s
hard disk.

This guide is organized into the sections described here:

This section includes:

e Information about World Class Manager

» List of typographical conventions

* Instructions for:
* installing the World Class Manager program
» starting World Class Manager

This section includes five tutorials that demonstrate how to get
the most from World Class Manager. Please take the time to
complete the first four tutorials. If you plan to deliver activities
online, you will find the last tutorial very helpful.

This section consists of descriptions for each World Class
Manager operation. The operations are presented in the order
they appear in the menus.

* Appendix A lists hardware and software requirements.

* Appendix B provides a quick reference to keyboard
shortcuts.

* Appendix C shows the ‘hot spots’ that can reduce your use
of the menus.

* Appendix D explains the use of box plots in many World
Class Manager reports.

* Appendix E explains how to use the multiple selection lists
found in some World Class Manager dialogs.

1-1



GETTING STARTED

Typographical
Conventions

Before you Begin

1-2

These typographical conventions make the user’s guide easier
to read and use:

*  Step-by-step procedures begin with a “To’ and end with a
colon. Follow the instructions carefully. Look for these To
statements when reviewing a specific procedure. For
example:

To create a new gradebook:

* Text you are asked to enter from the keyboard is printed in
a typeface like this:

Jones, John

* Note boxes contain information that will enhance your
knowledge of World Class Manager. For example:

Note:
Take time to read Note boxes and you will save time
preparing grades. Note boxes provide information that
can improve your efficiency in using World Class
Manager.

We assume you know how to operate your Windows system. If
you are unfamiliar with any of the following tasks and terms,
consult your Windows manual or ask a colleague for help.

* Dialog box

e Text box

e Scroll bars

e Buttons

*  Open afile

e Save afile

e Click and double-click

* Select text with the mouse

e Select menu items

e Size and move windows



GETTING STARTED

Installing World
Class Manager

To install Thomson World Class Learning™ Testing
Tools, including World Class Manager, from CD:

3.

Note:
World Class Manager is part of Thomson World Class
Learning™ Testing Tools. If you have already installed
Thomson World Class Learning™ Testing Tools, you
have also already installed World Class Manager.

Insert the Thomson World Class Learning™ Testing Tools
CD in your computer’s CD-ROM drive.

In Windows 95, 98 and NT, select Run from the Start menu
and type d: \ set up95. exe. Click on the OK button.

In Windows 3.1, open the Program Manager. Select Run
from the File menu and type d: \ set up31. exe. Click on
the OK button.

Follow the instructions of the installation program.

To install World Class Manager from diskette:

1.

3.

Insert the World Class Manager diskette in your computer’s
diskette drive.

In Windows 95, 98 and NT, select Run from the Start menu
and type a: \ set upngr . exe. Click on the OK button.

In Windows 3.1, open the Program Manager. Select Run
from the File menu and type a: \ set upngr. exe. Click on
the OK button.

Follow the instructions of the installation program.

1-3



GETTING STARTED

Starting World Class
Manager

Technical Support

1-4

To start World Class Manager in Windows 95/98/NT:
1. Start Windows 95, 98 or NT.

2. Click on the Start button from the taskbar.

3. Select the Programs item.

4. Select the TWCL Testing Tools item.

5. Select the World Class Manager item.

To start World Class Manager in Windows 3.1:

1. Start Windows 3.1.

2. Double-click on the TWCL Testing Tools program group.
3. Double-click on the World Class Manager icon.
Technical support is available Monday through Friday between
8:30 a.m. and 6:00 p.m., Eastern Standard Time, at the
following toll-free number:

1-800-423-0563

You can also email your questions to support@kdc.com or fax
them to 606-647-5045.



TUTORIAL 1: THE BASICS

Objectives Tutorial 1 illustrates the basic operations in World Class
Manager.

Upon completion of Tutorial 1, you should be able to:
* Create a new gradebook
Add students

Add activities

Enter scores

Delete a score

Delete a student

* Save a gradebook

Print a gradebook

¢ Close a gradebook
 Exit World Class Manager

Create a new To create a new gradebook:
gradebook
1. Launch World Class Manager.

2. Choose New from the File menu or press Ctrl-N. A window
similar to the one below appears:

Chvprad Cherad ﬂ
Sl ey be =rade

e L]
Pl rameam
HWaamum

i WGy Ll;l

e The blank area at the top of the window will contain
activity names.

* The blank area on the left of the window will contain
student names.

* The blank area on the right side of the window will
contain percentages and letter grades for each student.

e The blank area at the bottom of the window will contain
statistics about each activity.

2-1



TUTORIAL 1: THE BASICS

Add students To add students:

1. Choose Add Student... from the Students menu or press
Ctrl-T. The following dialog appears:
Add Student

Name: I

ID: |

Password: I

MNote 1: I

Note 2: I

Cancel I 0K

2. Fill in the fields you need.

—Name—

Enter the student’s name in this field. To ensure proper
sorting, enter the student’s last name, a comma, and then
the student’s first name.

—ID#—
If you deliver online activities, students will use their ID to
access the activity. You can also post scores by student ID.

—Password—
If you deliver online activities, enter a password here. To
ensure security, do not assign the same password to each

student or one easily deduced by other students.

—Notel— & —Note2—
These fields can contain other information about a student.

For this tutorial, type Jones, John in the Name: field,
then tab to the ID# field and type 1000.

3. Click on the OK button or press Enter.
The name of the student appears on the left of the window.

4. Repeat steps 1 through 3 for the following students:

Student ID#
Brown, Lisa 1001
Lopez, Maria 1002
Chang, Robert 1003

2-2



TUTORIAL 1: THE BASICS

Add activities To add activities:

1. Choose Add Activity... from the Activities menu or press
Ctrl-A. The following dialog appears:

Add Activity

Name: I

Points: [100

gatggu[y: IDefauIt j

Note 1: I

Note 2: I

Cancel I Ok I

2. Fill in the fields you need.

—Name—
Enter the activity name in this field.

—Points—
Enter the number of possible points for the activity in this
field.

—Category—
After you define activity categories, you can use this drop-
down list to assign the new activity to one of the categories.

—Notel— & —Note2—
These fields can contain other information about an
activity.

For this tutorial, type Lab 1 in the Name: field and 50 in
the Points field.

3. Click on the OK button or press Enter.

The name of the activity (Lab 1) appears at the top of the
window.

4. Repeat steps 1 through 3 for the following activities:

Activity Possible Points
Lab 2 50

Lab 3 50

Midterm Exam | 100

2-3



TUTORIAL 1: THE BASICS

Enter scores

Delete a score

24

To enter scores:
1. Highlight the cell that will hold the score by clicking on it.

For this tutorial, click in the top left cell (John Jones’s score
for Lab 1).

2. Type in the score.
Type 46.

3. If more scores must be entered, use one of the following
methods to move to the next cell.
* Press the Enter key.
* Press the down arrow key.
¢ (Click in the next cell.

4. For this tutorial, enter the following scores, trying each of
the three methods in step 3.

Mid-
Students Lab1 Lab2 Lab3 Term
Jones, John 46 43 47 88
Brown, Lisa 45 40 38 94
Lopez, Maria 48 47 45 92
Chang, Robert 39 41 35 75

To delete a score:
1. Highlight the score to remove.
For this tutorial, click on Robert Chang’s score for Lab 3.
2. Press the delete or backspace key.
If the entire score was selected, one press will remove the
score. If the caret (|) appeared in the cell, press the delete

key once for each digit to the right of the caret and the
backspace key once for each digit to the left of the caret.



TUTORIAL 1: THE BASICS

Delete a student To delete a student:
1. Highlight one of the cells on the student’s row.

For this tutorial, click on the 40 that Lisa Brown earned in
Lab 2.

2. Choose Delete Student from the Students menu. World
Class Manager presents a confirmation dialog.

3. When the confirmation dialog appears, click on OK or press
the Enter key to confirm the deletion.

Note:
To delete an activity, follow the same steps with one
exception: choose Delete Activity from the Activities
menu.

Save a gradebook To save a gradebook:
1. Choose Save from the File menu or press Ctrl-S.

2. If the gradebook has never been saved, World Class
Manager asks for a file name and a file location in a
standard Save As... dialog.

For this tutorial, save this gradebook as Tut ori al . gbk in
the Tutorial subdirectory.

Mame the gradebook file to save ...

Save in: |@ Tutarial j gl IE_E;

File hame: ITutoriaI. gbk. Save I
Save as type: |Class M anager [.gbk) j Cancel |

Note:
If you want to save a copy of a gradebook with a
different name, in a different subdirectory, or on a
different disk, use the Save As... command on the File
menu.
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TUTORIAL 1: THE BASICS

Print a gradebook

Close a gradebook

Exit World Class

Manager

What next?

2-6

To print a gradebook:

1. Choose Print from the File menu or press Ctrl-P.
To close a gradebook:

*  Choose Close from the File menu or

* Press Ctrl-W or

*  Click the close button in the right corner of the window title
bar.

To exit World Class Manager:
e Select Exit from the File menu or

¢  Press Alt-F4 or

*  (Click the close button in the right corner of the program’s
title bar.

If you have time, you should go on to Tutorial 2.



TUTORIAL 2: USING REPORTS

Objectives

Open an existing
gradebook

Tutorial 2 illustrates how to use World Class Manager reports.

Upon completion of Tutorial 2, you should be able to:
* Open an existing gradebook
» Use various reports

Student report

Activity report

Missing Activities report
Class Summary report
Class Listing report

¢ Print a report
e Close a report window

Some World Class Manager reports use box plots to
help present results. If you are unfamiliar with box
plots, see Appendix D: Understanding Box Plots..

Note:

To open an existing gradebook:

1. Launch World Class Manager.

2. Choose Open... from the File menu or press Ctrl-O. World
Class Manager presents the standard Open... dialog.

Select a gradebook file to open . EHE

Loak in: IaTutoriaI j gl E_

Tutarial gk

Files of type: IEIass M anager [*.gbk) ﬂ Cancel |

3. Use the controls in the dialog to find the proper
subdirectory, highlight the gradebook to open, then click on
the Open button or press the Enter key.

For this tutorial, navigate to the Tutorial folder and open
the gradebook named Tutorial.gbk.

After a brief pause for loading, the gradebook reappears
with the following preserved:

Window size
Scroll position in the student list and the activity list.
Highlighted cell.

3-1



TUTORIAL 2: USING REPORTS

Use various reports

Student report

3-2

To this point, you have seen World Class Manager’s ability to
store information about students, activities and scores, to
calculate student grades and to calculate activity statistics. All
of this information is displayed in the gradebook window.

World Class Manager can also produce reports that go beyond
the information displayed in the gradebook window. These
reports appear in their own window.

To view a Student Report:
1. Highlight one of the cells in the student’s row.

For this tutorial, select John Jones’s score for Lab 3.
2. Choose Student from the Reports menu.

A report window similar to the following appears. The

report contains the following elements:

* The name of the gradebook and the name of the student
at the top.

* Box plots for each of the activities with the student’s
position within the box plot.

* The student’s overall score and overall grade.

Tutaorial. gbk - Jones, John

Lab Lab Lab Midterrm
1 2 3 Exam
43.0 [w] 470 w 470Mm S §2.0 [w]
FHH 5 HH =
H S
30w 410w 450 lal 750 m

Jones, John Owerall Score: 89,60
Jones, John Overall Grade: B+




TUTORIAL 2: USING REPORTS

Activity report

Missing Activities
report

To view an Activity Report:
1. Highlight one of the cells in the activity column.

For this tutorial, select Maria Lopez’s score for Lab 1.
2. Choose Activity from the Reports menu.

A report window similar to the following appears. The

report contains the following elements:

* The name of the gradebook and the name of the activity
at the top.

* A listing of all numerical statistics calculated by World
Class Manager.

* A box plot for the activity with the median score

indicated.
#1y Tutorial.gbk - Lab 1 [l =]
Tutorial.gbk - Lab 1
Average: 44.33
Median: 46.00 48.0
Minimum:  39.00 MED
Maximum: 48.00
StandDev: 3.86
Missing: D
Possible: 50 39.0
4 l I N A

To view a Missing Activities Report:
1. Choose Missing Activities from the Reports menu.

A window similar to the following appears. The report

contains the following elements:

* The name of the gradebook at the top.

» A listing of all activities with missing scores.

* For each listed activity, a list of students without a
score.

* The total number of missing activities.

a

Triaral gbk - WEong Ao mics

Todsd Wisrag A s

1| | Ll_
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TUTORIAL 2: USING REPORTS

Class Summary report To view a Class Summary Report:
1. Choose Class Summary from the Reports menu.

A window similar to the following appears. The report

contains the following elements:

* The name of the gradebook at the top.

* A histogram showing the distribution of letter grades.
=y (vl gkt Gl e MAREED

Timarialghi - Clags Samimany

. . o

Class Listing report To view a Class Listing Report:

1. Choose Class Listing from the Reports menu.

A window similar to the following appears. The report

contains the following elements:

* The name of the gradebook at the top.

e A listing than contains the name, ID, overall score and
overall grade for each student.

',‘..;I. Tutorial_gbk - Class Listing

Tutorial gbk - Class Listing
Mame D Score Grade
Lopez, Maria 1002 93.00 A
Jones, John 1000 8967 B+
Chang, Robert 1003 VBB C
4| o]
Note:

The items included in the Class Listing report can be
changed. See Tutorial 4 or Class Listing... in the
Command Reference.
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TUTORIAL 2: USING REPORTS

Print a report

Close a report
window

What next?

To print a report:

1. Make sure that the window that contains the report is on
top.

2. Choose Print from the File menu or press Ctrl-P.
To close a report window:

* Choose Close from the File menu or

* Press Ctrl-W or

*  Click the close button in the right corner of the report title
bar.

If you have time, you should go on to Tutorial 3. If not, you
should exit World Class Manager.
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TUTORIAL 3: DEFINING ALTERNATE GRADING METHODS

Objectives

Set up Tutorial 3

Define weighting
parameters

Tutorial 3 illustrates how to define alternate grading methods.

Upon completion of Tutorial 3, you should be able to:
* Define weighting parameters

* Add new categories

* Set category characteristics

* Group activities into categories

* Save weighting parameters
* Define letter grades and criteria

¢ Change the criterion for a grade

* Remove a grade

e Save the letter grades and criteria

To begin this tutorial, make sure the Tutorial gradebook you
saved in Tutorial 2 is loaded in World Class Manager.

To define weighting parameters:

1. Choose Score Weighting... from the File/Preferences menu.
The following dialog appears:

Score Weighting
LCategories Included Activities
Default =] [Lab1 =
Lab 2
Lab 3
Midterm Exam
|
3 ﬂeight:l"]l].l]l]
" Ignore highest
I Ignore lowest
F{cmugel Renamel Add I LI

" Use as default Revert | Cancel | ok |

Note:
The Weighting Setup dialog uses a multiple selection
list. If you are unfamiliar with multiple selection lists,
see Appendix E: Using Multiple Selection Lists.

4-1



TUTORIAL 3: DEFINING ALTERNATE GRADING METHODS

Add new categories To add new categories:

1. Type the name of the category into the edit field below the
list of categories.

For this tutorial, type Labs.

2. Click on the Add button. The new category is added to the
category list.

For this tutorial, repeat steps 1 and 2 to create a second
category named Test s.

Set category To set category characteristics:
characteristics
1. Highlight the category in the list by clicking on it.

For this tutorial, click on the Labs category.
2. Type the weight value into the Weight: field.
For this tutorial, enter 1 for the weight of Labs.

3. Review status of Ignore highest and Ignore lowest check
boxes.

For the Labs category in this tutorial, check the Ignore
lowest check box and leave the Ignore highest check box
unchecked.

Group activities into To group activities into categories:
categories
1. Highlight the category in the list by clicking on it.

For this tutorial, you should not have to click on the Labs
category, since it is already highlighted.

2. Highlight the activities in the activities list that should be
in that category.

For this tutorial:

e Click on Lab 1 in the activities list and hold the mouse
button down.

e Drag the mouse through Lab 3, then release the mouse
button. This will group labs 1 through 3 in the Labs
category.

Now repeat the procedures above to set the weight of the Tests
to 2 and place the Midterm Exam into the Tests category.

4-2



TUTORIAL 3: DEFINING ALTERNATE GRADING METHODS

Save weighting To save weighting parameters:
parameters
* Click on the OK button to accept the changes to the
weighting parameters.

With the weighting parameters set in this tutorial, the
Midterm Exam (with a weight of 2) counts for two-thirds of a
grade with Labs 1 through 3 (with a weight of 1) counting for
one-third. The lab with the lowest score will be ignored in the
grade calculations.

Define letter grades To define letter grades and criteria:
and criteria

1. Choose Grade Criteria... from the File/Preferences menu.
The dialog below appears:

Grade Critena

Grades

At -

A

A

B+

B

B- |

Minimum Percentage: I

Flemugel Flgnamel Add |

Bevert | Cancel |

[ Use as default

Change the criterion for To change the criterion for a grade:
a grade
1. Click on the grade to change.
For this tutorial, click on A.

2. Enter the new minimum percentage required to earn the
grade.

For this tutorial, type 95.
Remove a grade To remove a grade:
1. Click on the grade to remove.
For this tutorial, click on A+.

2. Click on the Remove button.
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TUTORIAL 3: DEFINING ALTERNATE GRADING METHODS

Save the letter grades To save the grading criteria:

and criteria
1. Click on the OK button or press the Enter key.

What next? If you have time, you can go on to Tutorial 4. If not, you should
exit World Class Manager.
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TUTORIAL 4: CUSTOMIZING WORLD CLASS MANAGER

Objectives

Set up Tutorial 4

Change the activity
summaries

Tutorial 4 illustrates how to customize World Class Manager.

Upon completion of Tutorial 4, you should be able to:
* Change the activity summaries.
* Change the order of the students.
* Change the appearance of the gradebook
* Create a custom report.
*  Manage multiple open windows.
e Tile the windows
e Cascade the windows
* Bring a window to the top

To begin this tutorial, make sure the Tutorial gradebook you
saved in Tutorial 3 is loaded in World Class Manager.

To change the activity statistics:

1. Choose Activity Summaries from the File/ Preferences
menu. The following dialog appears:

Activity Summaries

Displayed Statistics

Average
Minimum
Maximum
Median

Standard Dev
Possible

BRevert I Cancel I

™ Use as defaull

2. Control-click on the list to change the set of highlighted
statistics.

Click with the Control key down on an item that is not
selected to select it.

Click with the Control key down on an item that is selected
to deselect it.

For this tutorial, hold down the Control key and click on
Possible (to select it) and on Minimum (to deselect it).

3. Click on the OK button or press the Enter key to save the
changes.

The statistics at the bottom of the gradebook now include
those selected in the Activity Summaries dialog.
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Change the order of To change the order of the students:
the students
1. Choose Sort Students... from the Students menu. The
following dialog appears:
Sort Students

Name [ascending]

Student ID [ascending]
Overall Score [descending)
Current Activity Score [desc.]
Missing Activity [descending]
Student Notel [ascending]
Student Note2 [ascending]
No sorting

olielielelielieliele

Bevert I Cancel I

I” Use as defauli

2. Click on the type of order you want.

For this tutorial, click on the Quverall Score (descending)
button.

3. Click on the OK button or press the Enter key to change the
student order.

The students with the highest overall score now appear at
the top of the gradebook.

Change the To change the appearance of the gradebook:
appearance of the
gradebook 1. Choose Gradebook Format...from the File/ Preferences
menu. The following dialog appears:
Gradebook Format
Cell widths ——— Font

Students: |15 Font: |Helvetica 'l
Activities: IB Size: |1|] 'l

¥ Don't show partial cells

" Use as default Revert | Cancel | ok |

2. Set the Student name width:
For this tutorial, change this value to 13.
3. Set the Activities name width:

For this tutorial, do not change this value.
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4. Set the Foni:

Click on this control to reveal the following drop-down list:

Fixed
Times
Helvetica
Courier
System

For this tutorial, select Times.
4. Set the Size:

Click on this control to reveal the following drop-down list:

9
10
12
14
18
24

For this tutorial, select 12.
5. Set the state of the Don’t show partial cells button.
For this tutorial, leave this unchecked.

5. Save the new format by clicking on the OK button or
pressing the Enter key.

The gradebook now displays its data in a 12 point Times

font with student list column just wide enough to show the
student names.
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Create a custom
report

5-4

To create a custom report:

1. Choose Class Listing... from the File/Preferences menu.
The following dialog appears:

Class Listing
Columns Activities
Lab 1 =]
Lab 2
Lab 3

Midterm Exam

Grade =l

" Use as default Revert | Cancel I 0K I

2. Control-click on the columns list to change the set of
columns included in the Class Listing report.

Click with the Control key down on a column that is not
selected to select it.

Click with the Control key down on a column that is
selected to deselect it.

3. If you include Activities in the column list, you can select
the activities included the Class Listing report.

Click with the Control key down on an activity that is
not selected to select it.

Click with the Control key down on an activity that is
selected to deselect it.

For this tutorial, hold down the Control key and click on:

Name to deselect it.
Activities to select it.
Each activity in the Activities list to select them.

4. To save these display settings, click on the OK button or
press the Enter key.

5. Choose Class Listing from the Reports menu to see the
changes.

This Class Listing report can now be printed for students to
view, while maintaining each student’s privacy.
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Manage multiple
open windows

Ttle the windows

Cascade the windows

Bring a window to the
top

What next?

To manage multiple open windows:

Within the limitations of memory, World Class Manager lets
you open as many windows as you like. The Window menu
provides ways to manage these multiple windows.

To appreciate the convenience of the Window menu, open the
following reports:

* C(lass Listing

e C(Class Summary

* Student report for Maria Lopez

e Activity report for Lab 3

To tile the windows:

e Choose Tile from the Window menu.
The size of each window is reduced and the position of each
window is changed so that each window can be seen at the
same time.

To cascade the windows:

*  Choose Cascade from the Window menu.
The size of each window is increased to a reasonable
maximum and the position of each window is changed so
that the windows resemble a stack of papers.

To bring a window to the top:

e Choose the window’s name from the list at the end of the
Window menu.

For this tutorial, choose Tutortal.gbk - Class Listing from
the Window menu. The Class Listing report is brought to
the top of the stack.

If you have time, you can close this gradebook and go on to
Tutorial 5. If not, you should exit World Class Manager.
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TUTORIAL 5: IMPORTING ONLINE SCORES

Objectives

Set up Tutorial 5

Import online
activity scores

Tutorial 5 illustrates how to import scores from an online
activity into World Class Manager.

Upon completion of Tutorial 5, you should be able to:

e Import online activity scores.

* Score subjective student responses.

* Perform item analysis on an online activity.

* View an online activity within World Class Manager.

To begin this tutorial, launch World Class Manager.

In this tutorial, you play the role of an astronomy instructor.
Your Introduction to Astronomy course has five students.
Using World Class Test, you have created their first exam and
published it online, using the local area network. Each of the
students has completed the exam, and you are now ready to
import their responses and judge how well they did.

To import online activity scores:

1. Open the gradebook that contains the students who
completed the activity.

For this tutorial, open the file named Astr_101.gbk, located
in the Tutorial directory.

The gradebook opens. The six students in the class appear
on the left side of the gradebook.

2. Choose Import Online Scores from the Activities menu.

3. In the Open... dialog that appears, select the online activity
file that contains the activity completed by the students.

For this tutorial, open the file named Astr_01.onl, located in
the Astr_01 directory, which is within the Tutorial
directory.

World Class Manager automatically scores the responses to
the objective questions. Once this is done, the activity is
added to the gradebook @f it does not already exist), and the
scores for each student appear in the activity’s column.
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Score subjective
student responses

6-2

If the online activity contains subjective questions (essay or fill
in the blank), World Class Manager lets you score each
student’s response to each subjective question.

To score subjective student responses:
1. Choose Import Online Scores from the Activities menu.

2. In the Open... dialog that appears, select the online activity
file that contains the activity completed by the students.

For this tutorial, open the file named Astr_02.onl, located in
the Astr_02 directory, which is within the Tutorial
directory.

As before, World Class Manager automatically scores the
responses to the objective questions, adds the activity to the
gradebook, fills in the scores for each student in the
activity’s column.

3. In the dialog that appears, enter the score earned by each
student for each subjective question.

Ouextian: J
|
Corsect finarwecr J
Bl
Erident Aespinse:
‘ |
=
Smdert Scare: | sulali I Sden Mame:
Preew Dutilian
Frepyw Higdeal Mt Hlideat
Hewd duesilan
Progresa: B ol  scersd Canos| | T |

4. Based on the student’s response, type the number of points
earned by the student.

For this tutorial, type 2.
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Perform item
analysis on an online
activity

5. Use the Prev Question, Next Question, Prev Student, and
Next Student buttons to navigate to the next response to
score.

By using the Prev Question and Next Question buttons, you
can concentrate on one student, moving from question to
question.

By using the Prev Student and Next Student buttons, you
can concentrate on one question, moving from student to
student.

6. To view the name of the student who gave the response,
click on the Student Name button. To return to anonymous
grading, click on the Student Name button again.

For this tutorial, use the navigation buttons that best fit
your style of grading. While you are scoring the responses,
click on the Student Name button occasionally to peek at
the student name.

7. When you are done scoring, click on OK.

The scores in the activity column update to reflect the
scores you have entered for the subjective responses.

Performing item analysis on an online activity lets you review
how well your students performed on each question in the
activity. By reviewing their performance, you can identify
questions that may need to be changed, or topics that are not
being mastered by your students.

To perform item analysis on an online activity:

1. Click on one of the score cells below the online activity in
question.

For this tutorial, click on the score Jack earned for the first
activity.
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6-4

2. Choose Item Analysis from the Reports menu.

A window similar to the one below appears:

;;:.Aclivily Item Analysis - Astronomy Quiz 1

Activity ltem Analysis - Astronomy Quiz 1
¥Yersion: 1 Mumber of Students: 6

Question 1 [Multiple Choice]

Response Upper Middle Lower
a 0% 0% 50%
*c 10026 10026 02
d 026 026 50%
Question 2 [Multiple Choice]
Response Upper Middle Lower —
a 50% 1002 50%
*h 50% 026 50%

Question 3 [Multiple Choice]
Response Upper Middle Lower
*a 1002 1002 1002

4| |’|_/!

In this report, the responses to each question are summarized
in a table. Each response selected by at least one student
appears in the left column. An asterisk (*) appears next to the
correct answer. The divisions Upper, Middle, and Lower appear
across the top of the table. These divisions represent the upper,
middle, and lower thirds of the class, according to student
performance on this activity. Within each table are the
percentages of students in each division who selected each
response.

The item analysis for question 1 shows that all of the upper
and middle students chose the correct answer, and that none of
the lower students chose the correct answer. This question does
a good job of discriminating between students who did well on
the activity and those who did poorly.

The item analysis for question 3 shows that all of the students
across all of the divisions answered the question correctly. This
question does not discriminate between students who did well
and those who did poorly. Optimistically, this item analysis
shows that all students have mastered the topic addressed by
question 3.

Note:
World Class Manager stores individual student
responses to each question only if the activity was
completed online. Because of this, item analysis is only
available for online activities.
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View an online
activity

What next?

Sometimes, it may be necessary to view the online activity as
the student saw it, complete with the student’s responses. This
report provides this service.

To view an online activity:

1. Click on the score earned by the student on the activity in
question.

For this tutorial, click on the score Jack earned for the
second activity.

2. Choose View Online Activity from the Reports menu.

3. In the Open... dialog that appears, select the online activity
file used to deliver the activity.

For this tutorial, choose Astr_02.onl, located in the Astr 02
directory, which is within the Tutorial directory.

A window similar to the one below appears:

','::,Jones, Jack - Astronomy Quiz 2 !E E
1. In what phase will the moon rise and zet with the sun? -
a. Full moon
b. HMew moon
. First guarter
d.  Third guarter
b

2, hat phase of the moon fol lows the waxing crescent phase?
Full moon

Mew moorn

First quarter

H
a
b
o
d Third quarter

d.

2. HWhere iz the international dote line? Hhy was it placed there?

It's i the muddle of the Pacific ocean. Tt was put
there so that tt's far away from Greenwich.

4. HWhat determined the location of the Tropic of Concer ond the Tropic of
Capricorn?

T don't know...

[

In this report, the questions presented to the student and their
responses appear in context. The text of the questions is black,
and the text of the responses is blue.

Congratulations! You have completed the last World Class
Manager tutorial. You should now exit World Class Manager.
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COMMAND REFERENCE

File Menu

New

Open...

Hew Ctel+H
Open... Chel+00
Cloze Chrl+af
Save Chrl+5
Save bz

Hewert

Freferences *
Print Sefup...

Frint.... Chrl+F

E it Alt+F4

Creates a new gradebook.

World Class Manager creates a new gradebook and places it in
a new window. It uses the preferences that were previously
saved (or default preferences if none saved) to determine
column widths, font to use, etc.

Opens a gradebook file.

Select a gradebook file to open ... HE
Lockin: |l Tutoril =] ==
Tutarial. gbk

Files of type: IEIass M anager [*.gbk) ﬂ Cancel |

Opens a gradebook file by prompting with a standard Open...
dialog. After a file is selected, World Class Manager places it in
a new window. The name of the file is displayed at the top of
the window.

—File name—
You can type the name of the file in this edit field or select the
file with the mouse.

—PFiles of type—

By default, World Class Manager displays only gradebook files.
Use this drop-down list to view all files.
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Close

Save

Save As...

Revert

Preferences

7-2

Closes the active window.

If there is unsaved work, World Class Manager first asks if you
want to save your work.

Saves the active gradebook.

The file to save the data to appears in the title bar of the
gradebook window. No file prompting is used with this menu
selection, unless the filename starts with “Untitled”.

Saves the active gradebook to a file to be named and a location
to be determined.

Mame the gradebook file to save ...

Save in: |@ Tutarial j gl IE_

File hame: ITutoriaI. gbk. Save

Save as type: |Class M anager [.gbk) j Cancel |

You are prompted with a standard Save As... dialog to save the
contents of the gradebook window.

Discards the changes you made since the last time you saved.
This command is useful when you’ve made changes that are
inconvenient or impossible to reverse. World Class Manager
asks you to confirm your intention to revert the data to its
previous state.

Menu options include the following:
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Score Weighting... Displays the Score Weighting dialog.
Score Weighting

Categories Included Activities

Default =] fLab1 =]
Lab 2
Lab 3
Midterm Exam

=

|
Iv! ﬂeight:l"]l].l]l]

" Ignore highest
™ Ignore lowest

Remogel Rename| Add I Ll

" Use as defaull Revert | Cancel I 0K I

Weighting lets you create categories and place activities into
them. A category has a relative weight and options for ignoring
the highest or lowest (or both) scores for activities in this
category. The relative weight number can be from any desired
range of values. The weights of all categories are totaled, and
an individual category’s percentage of this total is used to
calculate the score.

—Categories list—

In this scrolling list, you will see the categories that are defined
for the gradebook. The Default category is included in every
gradebook and cannot be removed.

—Category name—

Use the edit field below the Categories list to type a category’s
name. Use this field to define the name of a new category or
rename an existing category.

—Weight—
Use this edit field to define the weight the category is to have

when calculating student scores. Any number can be entered in
this field.

You can use numbers that are percentages that add up to 100.
For example, you can assign a weight of 25 to homework, 25 to
quizzes, and 50 to the final exam.

You can also use smaller numbers that express the relative
value of each category. The weighting defined in the example
above could be expressed as a weight of 1 for homework, 1 for
quizzes, and 2 for the final exam.
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—Ignore highest—
If checked, the highest score will be excluded from the
calculation of the overall score.

—Ignore lowest—
If checked, the lowest score will be excluded from the
calculation of the overall score.

The Ignore highest and Ignore lowest options are not used if
there are not enough scores. For example, if only one of these
options is checked, there must be at least two scores entered. If
both options are checked, there must be at least three scores
entered.

—Remove—

Removes a category from the gradebook. If any activities were
assigned to the category, they will be assigned to the Default
category.

—Rename—
Changes the name of the selected category to the name in the
Category name edit field.

—Add—

Adds a new category to the grade book as defined by the
Category name, Weight, Ignore Highest, Ignore Lowest, and
Included Activities list controls.

—Included Activities list—

This scrolling list shows the activities assigned to the selected
category. This scrolling list also lets you select different
activities to assign to the selected category.

—Use as default—

Saves the choices in the dialog so that new gradebooks will
inherit these choices. You must click on OK to save the choices
as the default.

—Revert—
Reverses the changes you made since the dialog appeared.
Unlike Cancel, the dialog remains open.

—Cancel—
Reverses the changes you made since the dialog appeared.
Unlike Revert, the dialog closes.

— OK—
Stores the information that appears in the dialog and then
closes the dialog.
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Grade Criteria... Assigns numeric cutoff values for grade names.
Grade Criteria
Grades
At -
A
A_
B+
B

B- |

Minimum Percentage: I

Remoge| F{gnamel Add I

Bevert | Cancel |

" Use as default

The Criteria dialog accepts numeric lower cutoff values to be
assigned to each grade. This is used to determine the overall
grade for each student. Note a 4.0 grade system can be used
instead of the letter grade A+ system. The grades must be
listed in top down, best to worst order. A self-check is made to
ensure the criteria are in descending order and a warning
message is displayed if they are not.

—Grades list—
This scrolling list shows the grades currently defined for the
gradebook and lets you select one of the grades.

—Grade name—
This edit field lets you change the name of an existing grade or
define the name of a new grade.

—Minimum Percentage—
Use this edit field to enter the minimum percentage a student
must earn to be awarded the selected grade.

—Remove—
Removes the selected grade.

—Rename—
Changes the name of the selected grade to the name in the
Grade name edit field.

—Add—
Adds a new grade as defined by the Grade name and Minimum
Percentage edit fields.

—Revert—
Reverses the changes you made since the dialog appeared.

Unlike Cancel, the dialog remains open.
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Activtty Summaries...

7-6

—Cancel—
Reverses the changes you made since the dialog appeared.
Unlike Revert, the dialog closes.

—Use as default—

Saves the choices in the dialog so that new gradebooks will
inherit these choices. You must click on OK to save the choices
as the default.

— OK—
Stores the information that appears in the dialog and then
closes the dialog.

Determines which statistics to display on the gradebook.

Activity Summaries [ X]

Displayed Statistics

Median
Standard Dev
Possible

Revert | Cancel I

[ Use as defauli

Actiuity Summarites options are for the information that
appears on the bottom of the gradebook. The choices are
activity average, minimum, maximum, median, standard
deviation, highest possible score and number of missing scores.
Any number of choices may be selected.

—Displayed Statistics list—

The selected items in this list will appear at the bottom of the
gradebook. To select an item that is not selected, or to deselect
an item that is selected, hold down the control key and click on
the item.

—Revert—
Reverses the changes you made since the dialog appeared.
Unlike Cancel, the dialog remains open.

—Cancel—
Reverses the changes you made since the dialog appeared.
Unlike Revert, the dialog closes.

—Use as default—

Saves the choices in the dialog so that new gradebooks will
inherit these choices. You must click on OK to save the choices
as the default.
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Gradebook Format...

— OK—
Stores the information that appears in the dialog and then
closes the dialog.

Display formatting options.
Gradebook Format
Cell widths ——————— Font

Students: |15 Font: IHeretica vl
Activities: IB Size: Ill] vl

¥ Don't show partial cells

" Use as defauli Revert I Cancel | OK I

Formatting options that control how a gradebook is displayed
are set in this dialog. The options are the student name column
width (from 1 to 30 characters), the activity name column
width (from 8 to 20 characters), font name and font size for
gradebook display, and whether to allow partial score cells to
be displayed when resizing the window. The font name and
font size also change the font for the missing activity, class
listing and student reports.

—Students—
Use this edit field to define the width, in characters, of the
students column at the left edge of the gradebook.

—Activities—
Use this edit field to define the width, in characters, of all
activity columns in the gradebook.

—Don’t show partial cells—

When this option is checked, World Class Manager will adjust
the size of the gradebook so that no partial rows or columns
will be shown.

—Font—

Use this drop-down list to select the type of font to use when
displaying and printing the gradebook. When you click on the
drop-down list, the menu below will appear:

Fixed
Times
Helvetica
Courier
System
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—Size—

Use this drop-down list to select the size of font to use when
displaying and printing the gradebook. When you click on the
drop-down list, the menu below will appear:

q
10
12
14
18
24

—Use as default—

Saves the choices in the dialog so that new gradebooks will
inherit these choices. You must click on OK to save the choices
as the default.

—Revert—
Reverses the changes you made since the dialog appeared.
Unlike Cancel, the dialog remains open.

—Cancel—
Reverses the changes you made since the dialog appeared.
Unlike Revert, the dialog closes.

— OK—
Stores the information that appears in the dialog and then
closes the dialog.

Class Listing... Customizable class listing options.
Class Listing
Columns Activities
Lab 1 =]
Lab 2
Lab 3

Midterm Exam

Grade =l

" Use as default Revert | Cancel | ok |

All the options for the Class Listing report are set here. The
selected options are then displayed left to right when a class
listing report is generated. Any number of activities can be

included in this report as well. The sequence of the options is
fixed.
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Print Setup...

—Columns list—

This scrolling list presents the columns that can be included in
a Class Listing report. Only those that are selected will
actually be included. To select an item that is not selected, or to
deselect an item that is selected, hold down the control key and
click on the item.

—Activities list—

If Activities is selected in the Columns list, you can use the
Activities scrolling list to choose the activities to be included in
the Class Listing report. To select an item that is not selected,
or to deselect an item that is selected, hold down the control
key and click on the item.

—Use as default—

Saves the choices in the dialog so that new gradebooks will
inherit these choices. You must click on OK to save the choices
as the default.

—Revert—
Reverses the changes you made since the dialog appeared.
Unlike Cancel, the dialog remains open.

—Cancel—
Reverses the changes you made since the dialog appeared.
Unlike Revert, the dialog closes.

— OK—
Stores the information that appears in the dialog and then
closes the dialog.

Lets you select printer options.

Print Setup 7]

r~ Printer

Mame: iHF' Lager et 44//404Y PostScript j Eroperties |

Status: Default printer; Ready

Type: HP Laserlet 44/ 40 PostScript
Where:  WWTeakhizdhpdsl

Comment:

~ Paper Drientatian —————————
Size: ILetter j " Pay
Source: IAutoSeIectTra}l j " Landscape

oK I Cancel |

While the dialog that appears on your computer may be
different, the Print Setup dialog generally you select the
printer, paper size, and page orientation.

7-9



COMMAND REFERENCE

Print

Exit

7-10

Used to print the active gradebook or report.

For large gradebooks, printing is tiled top to bottom, left to
right. Reports are generally printed in a WYSIWYG manner;
the way the information is displayed on the screen is the same
way the information is printed.

Used to exit World Class Manager.

If there are any unsaved gradebooks, you are first prompted
with the option to save your work.
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Edit Menu

Undo

Cut

Copy

Paste

Clear

E dit

Undo Chl+2

Cut  Chil+=
Copy  Chl+C
Fazte Chl+y
Clear

To undo a previous score change.
Can undo a paste or a score typing change.

Removes the highlighted score(s) and places it on the clipboard.
(Used with Paste.)

Makes a copy of the highlighted score(s) and places it on the
clipboard. (Used with Paste.)

Retrieves the score(s) you cut or copied to the clipboard and
places it at the cursor position. (Used with Cut and Copy.)

The current selection must match dimensionally the previously
cut or copied selection.

Deletes the highlighted score(s). (The score(s) are not cut to the
clipboard.)
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Students Menu

Student Info...
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Students
Student [nfo... Clrl+l
Add Student... Clrl+T

Delete Student

Sart Students. ..

Irpart Student List...

Displays a student data record.

Student Info

Name: |Jones, John

1D: [1000

Password: IJJ

Note 1: IAdmitlcd to major program

Note 2: I

Bevert I Cancel | 0K I

The currently highlighted student’s data record is displayed in
a new window. These data fields may be edited. The fields
displayed are:

—Name—
Contains the student name that appears at the left of the
gradebook. This name can contain up to 47 characters.

—ID—
Contains the student ID, which should be unique. This ID can
contain up to 11 characters.

—Password—
Contains the student password, which may or may not be
unique. This password can contain up to 13 characters.

To ensure the security of online activities, do not assign the
same password to each student or one easily deduced by other
students.

—Note 1—

Contains the student’s first note. You can use this field to store
any type of textual data. This note can contain up to 47
characters.

—Note 2—

Contains the student’s second note. You can use this field to
store any type of textual data. This note can contain up to 47
characters.
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Add Student...

Delete Student

—Revert—
Reverses the changes you made since the dialog appeared.
Unlike Cancel, the dialog remains open.

—Cancel—
Reverses the changes you made since the dialog appeared.
Unlike Revert, the dialog closes.

— OK—
Stores the information that appears in the dialog and then
closes the dialog.

Except for password, students in the gradebook can be sorted
using any of the above fields (via the Sort Student selection
under Students).

Allows a new student to be added.

Add Student

Mame: I

1D: |

Password: I

Note 1: I

Note 2: I

Cancel | oK |

Displays the same window as Get Student Info above, but all
fields are empty. The new student is added to the gradebook
after the currently highlighted student. To add before, hold
down the shift key with the menu selection.

For a description of the controls in this dialog, see Student
Info... above.

Deletes an existing student.

The currently highlighted student is deleted after a
confirmation dialog is answered.
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Sort Students...
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Sorting options for viewing gradebook data.
Sort Students

Name [ascending)

Student ID [ascending]
Overall Score [descending)
Current Activity Score [desc.]
Missing Activity [descending]
Student Notel [ascending]
Student Note2 [ascending]
Mo sorting

olie e le el lie e

BRevert | Cancel I

[ Use as defaull

Sorting options allow various ways of viewing the data
displayed on a gradebook. The options are to sort by student
name (ascending), student ID (ascending), overall score
(descending), currently highlighted activity’s scores
(descending), number missing activities (descending), student
note 1 or 2 (ascending), or no sorting.

Only one sorting option can be selected at a time.

—Order radio buttons—
Click on one of these radio buttons to select the order in which
the students should appear in the gradebook.

—Revert—
Reverses the changes you made since the dialog appeared.
Unlike Cancel, the dialog remains open.

—Cancel—
Reverses the changes you made since the dialog appeared.
Unlike Revert, the dialog closes.

—Use as default—

Saves the choices in the dialog so that new gradebooks will
inherit these choices. You must click on OK to save the choices
as the default.

— OK—
Stores the information that appears in the dialog and then
closes the dialog.



COMMAND REFERENCE

Import Student List...

Imports student information from a text file.

A standard Open... dialog appears so that the text file can be
selected.

The text file must be an ASCII file with one student per line. A
tab character must separate the pieces of information for each
student. The pieces of information must be in the following
order:

1. Name

2. ID

3. Password
4. Note 1

5. Note 2
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Activities Menu

Activity Info...

7-16

Activities

Activity Info...
Add Activiby. . Chrl+d,
Delete Activity

Irnpart &ctivity List. ..
Impart Online Scores. .

Displays an activity data record.

Activity Info

Name: iLab 1

Points: [100

gatggury: IDefauIt :.J

Note 1: Ime Chapter 1

Note 2: I

Bevert I Cancel | 0K I

The currently highlighted activity data record is displayed in a
new window. These data fields may be edited. The fields
displayed are:

—Name—
Contains the activity name that appears at the top of the
gradebook. This name can contain up to 47 characters.

—Points—
Contains the number of points available in the activity. This
number has a maximum of 999999.

—Category—

Contains a list of all activity categories defined in the
gradebook. With this drop-down list, you can place the activity
into one of the categories without using the Weighting dialog.

—Notel—

Contains the activity’s first note. You can use this field to store
any type of textual data. This note can contain up to 47
characters.

—Note2—

Contains the activity’s second note. You can use this field to
store any type of textual data. This note can contain up to 47
characters.

—Revert—
Reverses the changes you made since the dialog appeared.
Unlike Cancel, the dialog remains open.
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Add Activity...

Delete Activity

Import Activity List...

—Cancel—
Reverses the changes you made since the dialog appeared.
Unlike Revert, the dialog closes.

— OK—
Stores the information that appears in the dialog and then
closes the dialog.

Allows a new activity to be added.

Add Activity

Mame: I

Points: [100

gatggury: IDefauIt j

Note 1: I

Note 2: I

Cancel | Ok I

Displays the same window as Activity Info above, but most
fields are empty. The activity is added to the gradebook after
the current activity. To add before, hold down the shift key
with the menu selection.

For a description of the controls in this dialog, see Activity
Info... above.

Deletes an existing activity.

The currently highlighted activity is deleted after a
confirmation dialog is answered.

Imports activity information from a text file.

A standard Open... dialog appears so that the text file can be
selected.

The text file must be an ASCII file with one activity per line. A
tab character must separate the pieces of information for each
activity. The pieces of information must be in the following
order:

1. Name

2. Points

3. Category
4. Note 1

5. Note 2
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Import Online Scores...

7-18

Extracts each student’s responses from a World Class Test
online activity.

A standard Open... dialog appears in which you can select the
online activity file to be examined.

After examining the online activity file, World Class Manager
will judge each objective question. If the online activity
contains only objective questions, World Class Manager
determines the score of each test, and proceeds to Automatic
Entry of Student Scores, below. If the online activity
contains one or more subjective questions, World Class
Manager proceeds to Scoring Subjective Questions below.

To score subjective questions:

If the online activity contains one or more subjective questions,
you must score each subjective question for each student.
Scoring the subjective questions is accomplished with the
dialog below accessed through the Import Online Scores...
menu option:

Uurwbian: J
M
Carreet finameer J
B
Ewdeni Aesponse:
‘ [
-]
Smder Scare: | sulalE I Sadem Mame:
Prev Ouesitin
ey Slwdeal M Sl el
Mexd Quesiian
Progress: B ol B scarsd Cancs| T |

The dialog above contains the following elements:

—Question—
Contains the question as seen by the student.

—Correct Answer—
Contains the correct answer to the question.

—Student Response—
Contains the last version of the answer given by the student in
response to the question.
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—Student Score field—

Contains the score for the answer assigned by you.

—Student Name check box—
If checked, shows the name of the student currently being
scored

—Prev Student button—
Displays the response to the same subjective question by the
previous student.

—Next Student button—
Displays the response to the same subjective question by the
next student.

—Prev Question button—
Displays the response to the previous subjective question by
the same student.

—Next Question button—
Displays the response to the next subjective question by the
same student.

—Progress—

Tells you your progress in scoring the subjective questions.
The first number is the number of answers scored. The second
number is the total number of answers to be scored across all
students and all subjective questions.

—Cancel button—
Click Cancel to discard any scoring performed during this
session.

—OK button—
Click OK when you are done scoring. The scores assigned to
each student on each question will be stored in the gradebook.

If you did not score every question for every student, you can
import the online activity again. When you do, only the

unscored responses will appear in this dialog.

World Class Manager proceeds to Automatic Entry of
Student Scores below.
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Automatic Entry of Student Scores:

When all questions in an online activity have been scored,
World Class Manager automatically enters the scores into the
gradebook. If World Class Manager encounters an existing
score for the activity, you will have the following options:

* Replace this score and continue with the automatic entry
of scores

* Replace All existing scores without asking again

* Don’t Replace this score, but continue with the automatic
entry of scores

* Cancel the automatic entry of scores

After the activity’s scores are placed into the gradebook, the

summary statistics shown at the right and bottom edges of the
window are recalculated.
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Reports Menu

Student

Beportz
Student
Activity
ltem &nalysiz
Wiew Onling Activity
Mizzing Activities
Clasz Summary
Clazz Lizting

Note

Many of the reports generated by World Class Manager
use box plots to help present results. If you are

unfamiliar with box plots, see Appendix D:
Understanding Box Plots.

Displays the Student Report.

o7 Tutorial.gbk - Jones. John

Tutorial. gbk - Jones, John

Lab Lab Lab Midterrm
1 2 3 Exam
43.0 (m 470w 47.0 92.0 [w]
1S HH S
H S
CEAT ] 41.0 = 45.0 Ll 750 m

Jones, John Overall Score: 89.60
Jones, John Overall Grade: B+

|

Y

The Student Report displays the student’s name as a title and
shows how the student compares with the class for each
activity. The box plots provide information on each activity’s
class maximum, class minimum, and the student’s score
indicated by an ‘S’. Also shown in the box plot is a +1 standard
deviation from the class average. The report ends with this
student’s overall score and grade.
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Activity Displays the Activity Report.

Tutorial.gbk - Lab 1

Average: 44.33

Median: 46.00 48.0
Minimum:  39.00 MED
Maximum: 45.00
StandDev: 3.86

Missing: 0

Possible: 50 39.0

4| |_’|_/I

The Activity Report displays the activity’s name and all
available statistics about this activity. This includes the class
average, median, minimum, maximum, standard deviation,
number of scores missing, and total points possible. Also shown
in the box plot is a =1 standard deviation from the class
average, as well as the median as indicated by MED’.

Item Analysis Displays the Item Analysis Report.

;;:.Aclivil}l Item Analysis - Aztronomy Quiz 1

Activity ltem Analysis - Astronomy Quiz 1
¥ersion: 1 Mumber of Students: 6

Question 1 [Multiple Choice]

Response Upper Middle Lower
a 0% 0% 50%
*c 100% 100% 0%
d 0% 0% 50%
Question 2 [Multiple Choice]
Response Upper Middle Lower —
a 50% 100% 50%
*b 50% 0% 50%

Question 3 [Multiple Choice]
Response Upper Middle Lower
*a 100% 100% 100%

4 |'|_/I

The following item analysis is available for the objective

questions in an online activity:

* Percentage of correct responses versus incorrect responses

* Percentage of responses garnered by each choice

* Correlation between each choice and the test score earned
by those students selecting the choice

The following item analysis is available for the subjective

questions in an online activity:

* Distribution of scores for each question

* Correlation between the score awarded on each question
and the test score earned by those students awarded that
score
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View Online Activity Displays the Online Activity Report.

1. In what phase will the moon rise and set with the sun? Fe
Full moon

Mew maook

First guarter

Third gquarter

ccanTa

hat phase of the moon follows the waxing crescent phose?
Full moon

Mew maook

First guarter

U
a
b
c
d Third gquarter

d.

3. Hhere is the international date 1ine? Why was it plaoced there?

Tt's in the middle of the Pacific ccean. It was put
there so that it's far away from Greenwich.

4, HWhat determined the location of the Tropic of Concer ond the Tropic of
Capricorn?

I don't know. ..

|

This report recreates the online activity as the student saw it.

Missing Activities Displays the Missing Activities Report.
O . (1
Tidpriad ik - Plcsiag Ariwas B
Lab 3 Chang, Fakerd
Totad Fligging Acisies: 1 ||
i | e

The Missing Activities Report displays each activity with
missing scores, including student names. The total number of
activities missing is displayed at the end of the report.

Class Summary Displays the Class Summary Report.
=y Tt b Chary S MEDO|

Tirarialght - Clags Qemimany

£
I
B
-5
=m
=@
g
=M
=™
[

J . o

The Class Summary Report displays the gradebook’s name as a
title and a bar graph showing each overall grade’s frequency.
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Class Listing Displays the Class Listing Report.
;;:,Tulorial_gbk - Clasz Listing
Tutorial gbk - Class Listing
Marne 1D Score Grade
Lopez, Maria 1002 93.00 A
Jones, John 1000 B89 67 B+
Chang, Robert 1003 7B.67 C
4 >

The Class Listing Report displays the gradebook’s name as a
title and student information. All the fields are optional and
are set through the Class Listing... selection under
Preferences. The fields to select from include student name, 1D,
password, Notel, Note2, any number of activity scores, overall
score and grade.
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Window Menu

Tile

Cascade

Arrange Icons

(Window List)

W indow
Tile
Lazcade

Arrange lconz

v 1 Tutarial bl

Resizes and arranges open windows so all of them are visible
on your desktop. Each window is as large as possible.

Resizes each window to about 75% of the size of the task
window. Each window is offset horizontally and vertically so
that each window title is visible.

Places the minimized windows in a row from left to right at the
bottom of the task window.

Lists the windows currently open in World Class Manager. You

can make any of the windows the active window by choosing it
from this list.
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Help Menu Help
Help Topicz

About "world Clazz Manager...

Help Topics The World Class Manager help system provides online
information about all World Class Manager menu options.

To access the help system, select one:
» Select Help Topics from the Help menu.

»  Click on Help from the About World Class Manager...

dialog.
*  Press F1.
Windows 3.1 Help

Under Windows 3.1, World Class Manager presents the list of
Help Topics:

= “World Class Manager x|~
File Edit Bookmark Help

YWelcome to YWorld Class Manager
Technical Support
Command Reference
File menu
[l

Dpen....
Cloge

Preferences E

* Use the scroll bar to find the help topic you want to view.

*  Click to view the topic.

*  Click on the Contents button to return to the list of Help
Topics.

For more information about using the Windows 3.1 Help
Viewer, choose How to Use Help from the Help menu.
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Windows 95/98/NT Help

Under Windows 95, 98 and NT, World Class Manager presents
the Welcome Help Topic:

« World Class Manager [_ O] =]
File Edit Bookmark Options Help

Qontentsl Irdex | Each I Frint | e | ps |

Welcome to World Class Manager

Welcome to World Class Manager 1.0, International Thomson Publishing™s electranic
gradebook software.

World Class Manager allows you to:

«  Store your student’s scares.

«  Automatically recaleulate grades.

+  Entervyour own weighting and letter grade criteria.
«  View and print numerous reports.

+ Impot results from online activities.

To navigate to the other topics:
* Use the browse buttons (<< and >>).

After you have moved to other topics, click on the Back
button to return to previous topics.

Click on the Contents button to open the table of contents.
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If you click on the Contents button, the window below appears:
Help Topics: World Class Manager HE

Contents | Find |

Click a topic, and then click Dizplay. Or click another tab, such az Index.

Wwelcome bo Wwarld Clazs Manager
@ Technical Support
@ Command Feference

Prirt... Cancel

In this window, you can:

* Double-click on an item in the list preceded by a page with
a question mark to open that topic.

* Double-click on an item in the list preceded by a book to
open that book, revealing the book(s) and/or topic(s) within.

Click on the Find tab to search the entire help file for the word

you specify.
About World Class World Class Manager displays a dialog that tells you what
Manager... version of World Class Manager you are using.

About World Class Manager

World Class(j

Learni

If you call Thomson World Class Learning™ technical support,
please refer to the computer platform and the version number
at the bottom of the About World Class Manager... dialog.
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APPENDIX A: SYSTEM REQUIREMENTS

Computer:

Memory:

Operating System:

Disk Storage:

Display:

Printer:

Mouse:

World Class Manager is designed for use with PCs equipped
with a 386 processor (or later).

8 megabytes of RAM.
Microsoft Windows 3.1 or
Microsoft Windows 95 or
Microsoft Windows 98 or
Microsoft Windows NT 4.0

Your computer system should have about 2 MB of hard disk
space available for installation.

Any Windows compatible color display
At least 256 colors is recommended.

Any Windows compatible printer.

Any Windows compatible mouse.






APPENDIX B: KEYBOARD SHORTCUTS

Keyboard Shortcuts

Navigation Keys

Arrow Keys:

Tab Keys:

Scrolling:

Alt-F4 - File: Exit
Ctrl-A - Activity: Add...
Ctrl-C - Edit: Copy
Ctrl-I - Students: Info...
Ctrl-N - File: New
Ctrl-O - File: Open...
Ctrl-P - File: Print
Ctrl-S - File: Save
Ctrl-T - Students: Add...
Ctrl-V - Edit: Paste
Ctrl-W - File: Close
Ctrl-X - Edit: Cut

Ctrl-Z - Edit: Undo

World Class Manager supports keyboard navigation around the
gradebook.

When the cursor is in caret mode, the left and right arrow keys
move the caret and the up and down arrow keys move the
highlighted cell. If any text is selected, all arrow keys move the
highlighted cell.

The Tab key moves the highlighted cell one over to the right. A
Shift-Tab moves the highlighted cell back one to the left.

When a highlighted cell is moved to a cell that is currently not
visible, the gradebook scrolls to show highlighted cell. The
gradebook can be scrolled with the scroll bars or through the
Page Up and Page Down keys as well as all the arrow keys
when at the edge.






APPENDIX C: GRADEBOOK HOT SPOTS

Gradebook Hot
Spots

O: Activity Info

O: Score Weighting

O: Grade Criteria
O: Student Info
0,0: Student Report

O: Activity Summaries

O: Activity Report

0,0: Class Summary

World Class Manager recognizes certain areas of the gradebook
as hot spots. By clicking on these hot spots, you can avoid using
the menus.

i 0 LR

o ®  ®
e ® ® o

g M o

Same as choosing Activity Info... from the Activities menu.

Same as choosing Score Weighting... from the Preferences
menu.

Same as choosing Grade Criteria... from the Preferences menu.
Same as choosing Student Info... from the Student menu.
Same as choosing Student from the Reports menu.

Same as choosing Activity Summaries... from the Preferences
menu.

Same as choosing Activity from the Reports menu.

Same as choosing Class Summary from the Reports menu.

C-1






APPENDIX D: UNDERSTANDING BOX PLOTS

Why use box plots?

Components of a box
plot

Highest score

Lowest score

Distribution of scores

Average score

Student score

Median score

Box plots are a common statistics tool to graphically represent

a distribution of values. After becoming familiar with the

components of a box plot, you will be able to gain insights into:

*  How well a student performed in relation to the other
students.

» How well the class performed as a whole.

The following represents a typical box plot:

42.0 [m|

380 =m

The highest score is shown at a black square at the top of the
box plot. The value of the highest score (48.0 in the example
above) appears to the left of the black square.

The lowest score is shown at a black square at the bottom of
the box plot. The value of the lowest score (38.0 in the example
above) appears to the left of the black square.

The range that includes the scores within £1 standard
deviation is shown as a long narrow box. This range in the
example above extends from about 47.5 down to 40.5.

The average score, calculated as a simple mean, is shown as a
horizontal line in the middle of the long narrow box. In the
example above, the average score is 44.0.

When a student is the focus of the report, the student’s score is
indicated with a horizontal line near an ‘S’. In the example
above, the student’s score appears to be 46.

When an activity is the focus of the report, the median (middle)

score on the activity is indicated with a horizontal line near a
‘MED’ label.






APPENDIX E: USING MULTIPLE SELECTION LISTS

What are multiple Programs use multiple selection lists so that one or more items

selection lists? in the list can be selected. World Class Manager uses multiple
selection lists in the Score Weighting, Activity Summaries, and
Class Listing dialog boxes.

Using multiple World Class Manager uses standard Windows conventions in

selection lists its multiple selection lists. The techniques you learn here
should apply to other programs that use multiple selection
lists.

Selecting a single item To select a single item:

o If the item is not already selected, simply click on it.

o If the item is already included in a set of selections, simply
click on it. The other items will become unselected.

Selecting a contiguous To select a contiguous range of items:
range of items
1. Click on the first item in the range and hold the mouse
button down.
2. Drag the mouse down to the last item in the range.

3. Release the mouse button.

The entire range from the item on which the mouse was
pressed to the item on which the mouse was released is now

selected.
Selecting or deselecting To select or deselect an item without affecting other
ttems without affecting items:

other items
* Hold down the Control key and click on the item.

If the item was not selected, it is now selected. If the item

was selected, it is now no longer selected. If any other items
were selected, they remain selected.
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Hot Spot C-1

Import a list 7-17
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Cascade 7-25
Clear

highlighted text 7-11
Copy

highlighted text 7-11
Cut

highlighted text 7-11

Editing
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Format 5-2
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Installation 1-3
Installation CD 1-1
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Keys
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Remove 4-3
Save 4-4
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Multiple selection lists E-1

o
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Import 6-1
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Paste
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Hot Spot C-1
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